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TEHNOLOGIJA IZRADE DIJELOVA TRAKASTOG TRANSPORTERA
PRIMJENOM CAD-CAM POVEZIVANJA

TECHNOLOGY OF ROLLER BED BELT CONVEYOR MANUFACTURE BY
IMPLEMENTATION OF CAD-CAM CONNECTION

Marijan BENCIC — Branimir BARISIC — Gyula VARGA — Miroslav PLANCAK

SaZetak: Rad prikazuje tehnologiju izrade trakastog transportera (materijala AISI 304L) od modeliranja dijelova uz
pomo¢ racunala, sklapanja svih dijelova transportera u virtualni sklop i izradu dijelova transportera primjenom CAD-
CAM povezivanja. Proizvodnja koristenjem CAD-CAM pristupa se mozZe optimizirati i lako kontrolirati, iz cega
proizlazi brza, kvalitetnija i efikasnija proizvodnja.

Kljuéne rijeci: — oblikovanje lima

— trakasti transporter
— modeliranje

Abstract: The paper presents the technology for the roller bed belt conveyor (material AISI 304L) from modeling of
parts by usage of computer, joining of all conveyor parts in virtual assembly and manufacturing of parts by
implementation of the CAD-CAM connection. With the use of the presented CAD-CAM approach, production can be

optimized and easily controlled, with the goal of a faster and more efficient production of a higher quality.

Keywords: — Sheet metal forming
— Roller bed belt conveyor
— Modeling

1. UVOD

Danas$nja moderna proizvodnja nezamisliva je bez
upotrebe racunala koje predstavlja osnovu za izradu 2D
ili 3D konstrukcija, izradu nacrta i direktnog povezivanja
raCunala sa strojem, sve u cilju brze, kvalitetnije i
efikasnije proizvodnje [1-5]. U danaSnje vrijeme
konkurencija je sve nemilosrdnija i ako Zelite provesti
znacajnija poboljSanja koja ¢e donijeti bitnije promjene
unutar kompanije kao §to je npr. skraCenje trajanja
razvojnog ciklusa proizvoda, upotreba 3D modeliranja
postaje nesto neminovno. Sa SolidWorks programskim
paketom bez puno muke mozete napraviti iskorak u svijet
3D modeliranja a da pri tom i dalje u potpunosti koristite
sve podatke koje ste godinama stvarali u 2D. Pri izradi
dijelova trakastog transportera [1] biti ¢e prikazan pristup
naprednog modeliranja pomocu SolidWorks programa s
kona¢nom svrhom izrade razvijenog oblika dijela, kako
bi se napravio pogodan CAD oblik za stvaranje CNC
koda za daljnju proizvodnju.

Dakle sa napravljenim 3D modelom dijela, kreée se sa
stvaranjem razvijenog virtualnog dijela, na ¢ijoj osnovi

1. INTRODUCTION

Today, modern manufacturing is unimaginable without
the use of a computer, which represents the fundamental
basis for production of 2D or 3D constructions, draftings
and direct connection of a computer with machine, all
with the goal of faster and more efficient production of a
higher quality [1-5]. Nowadays, the competition is
getting more merciless and if you want to make some
significant improvement which will bring about
important changes in the company, as with shorter
development production time, use of 3D modeling
becomes something that is inevitable. With the
SolidWorks program packet, you can easily get into the
world of 3D modeling, still using all the data that you
created for years in 2D. During the production of parts of
the roller bed belt conveyor [1], you will see the
approach of advanced modeling with the SolidWorks
program, with the final goal of making a developed body
shape, in order to make an appropriate CAD shape for
generating CNC code for further production.
Furthermore, with a modeled 3D part begins the
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programer izraduje NC program za sve strojeve koji se
koriste za proizvodnju dijela. NC program govori stroju
koje operacije treba izvrSiti [6]. Danasnji NC programi
izraduju se poluautomatski ili automatski, koristenjem
softvera za programiranje koji sadrze precizne
informacije o stroju i alatima. Programer odabire obradnu
strategiju, izabire alate, i optimizira parametre. Tada, s
jednostavnim klikom na mis, programer kazuje softveru
za programiranje, da generira NC program. ToPs
program biti ¢e koristen za izradu CNC koda za obradu
na strojevima [7].

2. MODELIRANJE
TRANSPORTERA U
KORISTENJEM  NAPREDNIH
METAL FUNKCIJA

DIJELOVA
SOLIDWORKSU
SHEET

U tehnologiji oblikovanja deformiranja lima najvaznija
alatna traka SolidWorksa je Sheet Metal (slika 1). Ona
omogucéava oblikovanje limova. Limove mozZemo
savijati, dodavati i oduzimati dijelove, oblikovati provrte,
zaobliti rubove, razviti plast modeliranog dijela iz sheet
metala itd.

construction of the developed virtual part, on the basis of
which the programmer builds the NC program for all of
the machines which are necessary for production of the
part. The NC program gives instructions to the machine
on which operations need to be done [6]. Today, CNC
programs are created automatically or half-automatically,
by use of programming software which contains precise
information about machines and tools. The programmer
selects the work strategy, chooses the tools, and
optimises the parameters. Then, with a simple click of a
mouse, the programmer shows the software for
programming, in order to generate an NC program. The
ToPs program will be used for the production of the CNC
code for the analysis [7].

2. MODELING OF THE PARTS OF THE
TRANSPORTER IN SOLIDWORKS USING
ADVANCED SHEET METAL FUNCTIONS

In the technology of sheet metal forming, the most
important SolidWorks tool is sheet metal (Figure 1). This
tool enables forming of sheet metal. We can bend sheets,
add or cut parts, form holes, round off edges, unfold a
sheet of modeled sheet metal part etc.
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Corners | Forming Simple Hole

= @ Extruded Cut .!'.:.:. Unfold
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Slika 1. Sheet Metal alatna traka
Figure 1. Sheet Metal tool

Glavni koraci u procesu modeliranja dijelova trakastog
transportera koji ¢e biti izradeni iz lima su:

» Modeliranje sheet metal alatima,

» koristenje alata za oblikovanje,

» razvijanje modela,

» izrada crteza iz 3D modela.

Na pocetku modeliranja 3D dijelova, prva polaziSna
tocka je uvijek odabir ravnine u kojoj se pocinje crtati te
odabir naredbe za izradu Sheet Metal dijela. Nakon
izradenog sketcha dijela, dodajemo 3D parametre. Za Sto
efikasnije modeliranje bitno na nacrtu uociti profil koji je
zajednicki svim daljnjim savijanjima, odnosno polazisnu
bazu s kojom se moze rijeSiti najveéi broj savijanja. [8].
U slucaju dijela TD103-001-01-202 D2 to je okomita
popre¢na ravnina [1]. Dakle odabirom funkcije Base
Flange stvorit ¢e se taj profil u ravnini Front,
jednostavnim alatima za skiciranje te ¢e se izvrsiti
kotiranje zadanim dimenzijama [8]. Na slici 2 prikazan je
profil dijela TD 103-001-01-202_D?2 tijekom skiciranja.

The main steps in the modeling process of the roller bed
belt conveyor parts which will be build in sheet metal
are:

» Modeling with the Sheet Metal tools,

» Using forming tools,

» Unfolding the model,

» Making the drawings of 3D parts.
At the beginning of the 3D part modelling, the first step
is always choosing the plane in which you start sketching
and choosing the command for the modelling of sheet
metal parts. After the sketching part, 3D parameters are
added. For more efficient modelling, it is important to see
if the design has a profile that is common to all the
bendings in the model, with regard to the starting base
with which we can solve the most of the bendings. [8]. In
the case of the part 7D 103-001-01-202_D2, this is the
front plane [1]. Choosing the Base Flange function, the
profile of the front plane will be created with simple
sketch tools and it will be properly dimensioned [8]. In
the Figure 2 is shown the profile of the part TD 103-001-
01-202_D2 during the sketching.
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Slika 2. Profil dijela TD 103-001-01-202_D2 [1]
Figure 2. Profile of the part TD 103-001-01-202_D2 [1]

Nakon Sto je skiciranje zavrSeno, slijede¢i korak je
definiranje 3D komponente, radijusa savijanja i
definiranje korekturnog faktora K. Po izlazku iz sketch
naredbe, otvara nam se meni Base Flange function u
kojem definiramo 3D komponentu (slika 3).
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When the sketching is done, the next step is defining the
3D components, the bend radius and the K factor. When
the sketch function is closed, the Base Flange function
menu appears, in which the 3D parameters are defined.
(Figure 3).
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Slika 3.  Base Flange funkcija [1]
Figure 3. Base Flange function [1]

Na slici 3 prikazane su opcije funkcije Base Flange. Pod
poljem Direction 1, odabire se smjer izvlacenja profila i
duljina izvlacenja. Polje Direction 2, omoguéava nam
drugi tj. opcionalni smjer izvlacenja. U polju Sheet Metal
Parameters, unose se vrijednosti debljine lima i radijus

.,g“ 1400.00mm
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Figure 3 shows the options of the Base Flange function.
Under the field of Direction 1, the directions of extruding
the profile and the length of extruding have been chosen.
The Direction 2 field allows another - the optional
direction of extruding. In the Sheet Metal
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savijanja. Za polje Bend Allowance (dodanost-
umanjenost savijanju) moguée je odabrati izmedu K-
faktora i tablice savijanja. To znaci, da kada je modeliran
dio savijen, da bi se dobila koja je prava duljina tog dijela
potrebna za izradu, treba izraunati dodanost savijanju
(bend allowance) ili umanjenost savijanju (bend
deduction). To nam govori koliko treba dodati ili oduzeti
duzine da bi se dobila trazena vrijednost [§].

2.1. K-faktor

Dodanost savijanju izra¢unava se koristenjem K-faktora
po formuli:

the sheet metal thickness and the bending radius have
been defined. For the Bend Allowance field, it is possible
to choose between the K factor and the bend table. This
means that, when the modelled part is bended, for getting
the real length of the part used in the production, it is
necessary to calculate the bend allowance or the bend
deduction. This gives information about how much
length is needed to be added or removed to obtain the
right value [8].

2.1. K-factor

The bend allowance is calculated with using the K factor
such that:

BA=n(R+KT) A/ 180.

R — unutarnji radijus savijanja [mm].

K — faktor, koji je #/T.

T — debljina materijala [mm)].

t — udaljenost unutrasnje strane do neutralne plohe [mm].
A — kut savijanja u stupnjevima (kut kroz koji je materijal
savinut) [°].

Tension

Bend
Allowance

R — Inner bending radius [mm].

K — factor, which is ¢/T .

T — thickness [mm].

t — the distance between the inner part and the neutral line
[mm].

A — the bending angle in degrees [°].

Neutral Axis

Bend Allowance =BA

Neutral
s I-F|a1 Length L
L = X+Y+BA
Slika 4.  Prikaz izracuna dodanosti savijanja [1]
Figure 4. The calculation of the bend allowance [1]
2.2. Tablica savijanja 2.2. Bend table

Tablica savijanja (Bend Table) specificna je tablica
materijala koja sadrzi proracune savijanja temeljene na
debljini lima i radijusu savijanja, a formira se kao Excel
datoteka. Do podataka koji su uneseni u tablici savijanja
dolazi se reverzibilnim inZenjeringom, na nacin da se
uzme uska traka materijala, savije se i tada se izmjeri da
se izra¢una dodanost savijanju. Ta se tablica lako unosi u
SolidWorks na nacin da se odabere Insert->Sheet
Metal>Bend Table=>From File, ili na nac¢in da se iz Use
Bend Table padajuceg izbornika odabere u okviru Sheet

The bend table is a specific table of materials which
contains the bending calculations based on the thickness
and the bending radius. It can be made as an Excel file.
Also, reverse engineering gives the data that can be
imported into the bend table. It is easy to import this table
into SolidWorks, choosing Bend Table Insert->Sheet
Metal>Bend Table->From File, or by means of the Use
Bend Table falling menu in the Sheet Metal command

[8].
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Metal naredbe [8]. Na ovom projektu izrade svih dijelova
koristi se tablica savijanja (slika 5).

Slika 6 prikazuje savijen profil dijela TD 103-001-01-
202-D2.
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Slika 5. Tablica savijanja
Figure 5. Bend Table

Nakon $to je izraden osnovni profil, slijedi izrada provrta
te rezanje gornjeg dijela profila. Sve ovo vrlo
jednostavno se napravi koriStenjem funkcije Extruded
Cut. Potrebno je odabrati funkciju, skicirati dio koji
zelimo odstraniti, te odabrati duljinu na koju Zelimo
izraditi rez.

Na slici 7 je prikazan profil tijekom skiciranja provrta
(koji u sklopu sluze za prihvat gornjih valjaka) nakon
¢ega se oni modeliraju, te gotov dio TD 103-001-01-
200_D nakon koristenja funkcije Extruded Cut (slika 8).

On this project the Bend Table is used for producing all
parts (Figure 5).
Figure 6 shows the bended profile of the part TD 103-
001-01-202-D2.

Slika 6. Savijen profil dijela TD 103-001-01-202 D2
(1]

Figure 6. Bended profile of the TD 103-001-01-202 D2
part [1]

After the basic profile was made, the making of holes and
the cutting of the profile follows. All of this is simply
made by using the Extruded Cut function. It is necessary
to choose the function, sketch the parts that we want to
remove, and choose the length to which we want to cut
the part. In the Figure 7 is shown the profile during the
sketching of the holes (which are used in assembly to
accept the upper rollers support) after which they are
modeled, and the finished part TD 103-001-01-200 D
after using the Extruded Cut function (Figure 8).

Slika 7.

Prikaz dijela TD 103-001-01-202_D?2 tijekom
skiciranja provrta [1]

Figure 7. TD 103-001-01-202_D?2 during the sketching
[1]

Slijede¢i korak pri modeliranju dijela TD 103-001-01-
202 D2 je dodavanje bo¢nih stranica. Bocne stranice
izvedene su koriStenjem funkcije Edge Flange, koja je

Slika 8. Prikaz dijela TD 103-001-01-202_D2 nakon
izvrSenja naredbe Extruded Cut
Figure 8 TD 103-001-01-202_D2 after the using of

Extruded Cut function

The next step in modeling is adding the flank sides on
part TD 103-001-01-202 D2. The side bends are
modeled by using the Edge Flange function which is very
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vrlo slicna Base Flange funkciji. Potrebno je odrediti
rubove koje zelimo saviti, tj. rubove na koje Zelimo
dodati.

Odaberu se radijusi i tablice savijanja i rub je gotov.
Potreba popustanja na mjestima gdje bi dolazilo do
ulaska jednog materijala u drugi, rade se klasi¢nim
extrude/remove material funkcijama, prikazano na slici 9
u detalju.

[T -
" X
Flange Parametens

e“—‘

Edit Flange Profile|

Hange Length
Band

oL | | 4

Trim sicht bends
Offset

Slika 9.  Izrada rubova naredbom Edge Flange
Figure 9. Bending using Edge Flange function

similar to the Base Flange function. It is necessary to
define the edges we want to bend, i.e., the edges on
which we want to add material, material, and to choose
the radius and the Bend Table. The necessary releases in
places where one part enters in to another are done with
the classic Extrude-Remove material functions, as shown
in the details of the Figure 9.

Slika 10.  Prikaz gotovog dijela TD 103-001-01-202_D2 [1]

Figure 10. Modeled part TD 103-001-01-202_D2 [1]

Jedna od mogucnosti SolidWorksa je da za modelirani
dio, moze se napraviti njegov simetriéni dio. U sklopu
finalnog transportera nalazi se i dio koji je simetriCan
dijelu TD 103-001-01-202_D2. Mirror dijela napravi se
tako da se otvori nov assembly file u koji unosimo dio
koji je modeliran. Nakon toga odabiremo funkciju Linear
Component Pattern—>Mirror Components. U toj funkeciji
potrebno je odabrati part koji zelimo zrcaliti, te ravninu
oko koje zelimo zrcaliti predmet. U ova dva kratka
koraka, vrlo brzo se napravi simetri¢an dio. Nakon $to je
model dijela napravljen pristupa se izradi tehnicke
dokumentacije. Kote koje se unose iz modela, vodene
mjere, trebale bi biti uredno namjeStene u samom
modelu. To dovodi do jednostavnijeg prijenosa i manje
posla oko sredivanja crteza. Izmjene izgleda vrijednosti
kao $to su preciznost i tolerancije, mogu se naciniti na
razini modela. Te izmjene se prenose i kada je model vec¢
prije unesen u crtez.

One of SolidWorks possibilities is that for the modeled
part, you can make its symmetrical part. In the final
assembly of the transporter, there is a part which is
symmetrical to the TD 103-001-01-202 D2 part. The
mirror of the part generally is made by opening a new
Assembly file, in which we insert a modelled part. After
that, we choose the function Linear Components
Pattern—->Mirror Components. In that function we have to
choose the part that we want to mirror, and the plane
about which we want to mirror it. In these two short steps
you can easily make a mirror part. After the part is
modeled, we begin to compile the technical
documentation. Measures from the model, loaded
measures, should be properly fixed in the model. This
leads to easier transportation and less work in adjusting
the documentation. Modifications of the wvalue of
measures, such as precision and tolerance, can be done at
the level of the model. These changes are transported
even when the model is included earlier in the
documentation.
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S pocetnog prozora odabere se modul Drawing, zatim se
pojavljuje okvirni dijalog u kojem se moze odabrati
izmedu standardne veli¢ine formata crteza, korisnikove
postave dimenzije crteza i datoteke s predefiniranim
okvirom crteza.
Ponudeno je osam pogleda modela:

1. Prednji;
Straznji;
Lijevi;
Desni;
Odozgor;
Izometrijski;
Trimetrijski;

8. Dimetrijski.
Za svaki pogled moZze se odabrati izgled kao $to je zicani,
ukljucena ili iskljucena vidljivost skrivenih (nevidljivih)
crta, osjencanost pogleda s rubnim crtama ili bez njih.
Takoder je moguc¢e u svakom trenutku promijeniti i
mjerilo pogleda, te vrstu kota.
Na slici 11, prikazana je tehni¢ka dokumentacija izradena
za dio TD 103-001-01-202 D2. Iz ove tehnicke
dokumentacije posebnu vaznost ima razvijeni oblik
modeliranog dijela koji nam pokazuje kako treba biti
odrezan ili probijen pocetni oblik lima. Rupe, oblikovani
dijelovi, i crte savijanja takoder se prikazuju.

Nowvnhkwn

100 1300

From the basic window you choose Drawing, then a
menu shows up in which you can choose between the
standard documentation formats, users defined and from
predefined file data.

There are 8 views offered:

1. Front;
Back;
Left;
Right;
Up;
Isometric;
Trimetric;

8. Dimetric.
For any view you can choose a view as in the wireframe,
enabled or disabled views on the hidden lines, or
shadowed view with or without edge lines. Also it is
possible at any moment to change the scale, and the type
of quotation lines.
In Figure 11 is shown the technical documentation for the
TD 103-001-01-202 D2 part. In this technical
documentation special importance is on the unfold shape
of the modeled part, which shows how the basic shape of
sheet metal should be cut or punched. Holes, formed
parts, and the bend lines are also shown.

NounhkwD

Bhf

= 42
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Slika 11.  Prikaz izradene tehnicke dokumentacije [1]
Figure 11. Preview of the Technical Documentation [1]

Osim izrade tehnicke dokumentacije, moguce je
programom SolidWorks izraditi i sklop, odnosno spojiti
sve dijelove od kojih se sklop sastoji. Na ovaj nacin
sklapanja svih dijelova, moguce je uociti moguce greske
do kojih bi moglo do¢i u proizvodnji.

IZRADIT ZRCALHO & METRI?NU POZICIILE
TOM02-001-01-202_L2 - Sredisnji profil L2
1 KOM/SKLOP

Besides technical documentation, with the SolidWorks
program it is also possible to make an assembly, meaning
to mate all the parts that form the assembly. In this way
of mating all of the parts, you can easily find possible
issues that can occur in production.
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Slijedeca slika prikazuje trakasti transporter TD 103, te
strelica misa ukazuje na kojem se mjestu u sklopu nalazi
dio TD 103-001-01-202_D2.

Sklop TD 103 sastoji se od oko 100 razli¢itih dijelova.

The next figure shows the Roller Bed Belt Conveyor TD
103, and the mouse arrow shows the location of the part
TD 103-001-01-202_D2.

The assembly TD 103 contains around 100 different
parts.

+ -
Slika 12.  Prikaz gotovog sklopa trakastog transportera TD 103 [1]

Figure 12. The final assembly of the TD 103 [1]
3. ZAVRSNA IZRADA U TOPSU

Nakon §to je zavrSeno modeliranje svih dijelova trakastog
transportera u SolidWorks-u, te nakon spajanja svih
dijelova transportera u virtualni sklop ¢ime je provjerena i
potvrdena ispravnost svih dijelova, pristupa se izradi NC
programa. Izrada NC programa predstavlja posljedn;ji
korak prije pocetka izrade dijelova transportera.

Izrada NC programa za dijelove transportera vrsi se

3. THE FINAL PROGRAMMING IN TOPS

After the modeling of all parts in SolidWorks is done, and
after the mating of all parts in virtual assembly, which
allows us to check and confirm the validity of all parts,
starts the building of the NC program. The NC program
represents the last step before the beginning of the
production of all parts of the conveyor. The production of
the NC program is made automatically by using the ToPs

automatski  upotrebom  ToPs 300 [7] sustava 300 [7] system for programming, and for punching and
programiranja za  probijanje i kombiniranu  combined (laser/punching) treatment.
(laser/probijanje) obradu.
Drawing Import of CAD ToPs 600
inToPs 100/ 300 Drawings
G0 IGES, DXF, MI GE0

Configure Define
sheet machining
Generate
NC data

Data transfer to machine

Slika 13. 3 Koraka do izrade CNC programa [7]
Figure 13. 3 Steps towards the CNC program [7]

3 Koraka do izrade CNC programa:

1. Korak

Izrada nacrta u ToPs-u ili importiranje nacrta iz 2D ili
3D CAD sustava putem IGES, DXF ili MI sucelja. Nacrti
podesni za koriStenje u proizvodnji, osnova su brzog i
procesno sigurnog NC programa. Moguce je i izraditi
nacrt u ToPs 300 sustavu ili izvrsiti unos iz ToPs 600
sustava. ToPs automatski analizira svaki nacrt uzimajuéi
u obzir obradu koja slijedi.

3 Steps towards the CNC program:

1. Step One

Making a drawing in ToPs or importing the drawings
from a 2D or 3D CAD system by IGES, DXF or MI
interface. The drawings used in the production are the
basis of a fast and process safe NC program. It is possible
to make a drawing in the ToPs 300 system, or to import
from the ToPs 600 system. ToPs automatically analyses
every drawing, considering the treatment that follows.
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Otvorene konture postaju zatvorene, konturni prijelazi
izgladeni, nadodani elementi obrisani.

2. Korak

Nakon unosa crteza slijedi konfiguriranje lima radi
maksimalnog iskoriStenja, paralelno sa definiranjem
samog procesa obrade, nakon Cega slijedi generiranje NC
koda (slika 14).

TC500 Typ 3 Bo CC 220

723.880  -129.141

Comnand?

Slika 14.  Konfiguriranje lima, jedan dio [1]
Figure 14. Sheet metal configuration, single part [1]

3. Korak

Prijenos programa na upravljacku jedinicu stroja.
Program ToPs podrzava i opciju izrade radnog naloga sa
Sifrom 1 popisom alata, te pozicijama i dimenzijama.
Jednostavnom klikom dobije se radni nalog sa navedenim
podacima. Radni nalog se moze vidjeti na slici 15.
Na slici 16 prikazan je probijen dio TD 103-001-01-202-
D2.

TO103_001_01_202_D2

TRUMPE
DOPERACIJA PROBIJANJA Izradic:
RADNINALOG br. Datum: 01.07.2008
[sTRos [TC2000 - TYPE: 1, Ba Typd VARWANT. 1
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DAL FRONI1-CADC AMISCLIDWORK ! PROJEKTIEIDIEBEL MGENIERIESFINNEROFIT RANSFORTER_DBBLI121-5_|EMAVRETD
103 ZBOBSTOFSTORS_KONSTRUKCLIATDNDA-001-01-202_02_X1 LST

TD103_001_01_202_D2 (TD103-001-01-202_D2_X1)

FracrRamM HaE:

T4t SIFRA AT FORMAT-1430 8 510 x 1 Smm (8564221 kgl |SKART:4.67 %
002 TR | REALNG VR: BRCU FONAVLIANIA |
5 @
FinPozICUA 1 FRCM THE LEFT
[PocETNA ToGKA X = 215,000 ¥ = 140,016 me
eapongrs
LISTA ALATA
SiFRa aLATA [TIP [T DRz D3 KUT GRS e [WT o7 [ PTT ars TOC | BDC [STROSENGST ALATA | STROKES
01080000 | 0 0e00 0000 0000 o 1 o | ] [agou | [
3300000 00 0000 08000000 o 1 o | 0
G4IT0S0 |4 (37000 5000 0000 0000 o 1 o |
0TN00 |1 |TOM 0000 0000 0000 o |1 |o
010000 |1 11000 0000 0000 0000 o 1 o |
4300020 4|20 ama 0000 o v o |
17IEEN0 |17 |15.000 20000 7000 0000 o [t o |
030000310000 0000 0000 0000 |3 o v o |

BR0) DRZACA ALATA 81 0

T GAIACIE © ZRATRY

rozcn ||| sros o e D
1 B (1] i e TO0001.01202 02 woeac: B
' B DIMENZS J'. POVRSINA
- - | B TR g0k 80207 e TIRSNA ggsz0immz | wise 8238k

Slika 15.  Radni nalog [1]
Figure 15. Work order [1]

Opened contours becomes closed, contour crossings are
shaped, and added elements are erased.

2. Step Two

After importing the drawings follows configuration of
sheet metal because of maximum efficiency, parallel with
the defining of the process treatment, and the generation
of the NC code (Figure 14).

NC program
Sheet layout

Create Modify
Modify shest Loading
Modify part Clamps

Construction line
2points Parallel
Horizontal Vertical

TanPt Perpendicular

Angle X Tan2el

Anglelline Division

Construction circle
3 points Centeriradius

Diameter Centerldia

Concentric

2an 1pt Tan 2pts
3Tan Tan center

Measuring

2points Point
Horizontal Vertical

Circle Angle

Ll | [ DIN[DRISIRD / | oo cmctonse_]

3. Step Three

Transfer of program to control unit of machine. The
program ToPs supports the option of making a work
order with a code and a list of tools, including positions
and dimensions. With a simple click you get a work order
with the mentioned data. A work order is shown in Figure
15. Figure 16 shows the punched part TD 103-001-01-
202-D2.

Slika 16.
Figure 16. Punched part [1]

Probijen dio [1]
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4. ZAKLJUCAK

Computer Aided Drafting ili Design (CAD) i Computer
Aided Manufacturing (CAM) je softver koji pomaze pri
konstruiranju, razvoju i optimizaciji dijelova. Oni su
zamjena za tradicionalno inZenjerstvo. CAD omogucuje
konstruktoru konstruiranje i razvoj rada na ekranu, ispis
dokumentacije i omoguc¢ava da se rad sacuva za buduce
koriStenje, eventualno editiranje tj. prilagodavanje
postoje¢eg modela kod modeliranja novog. Ovime se
skracuje vrijeme potrebno za modeliranje novih dijelova.
Moze se re¢i da CAD stvara beneficije kao §to su manji
troskovi razvoja proizvoda 1 skradeno vrijeme
konstruiranja. CAM je programski alat koji omogucuje
proizvodnju fizickih modela koriste¢i CAD programe.
Ovaj rad predstavio je jednu takvu CAD - CAM
proizvodnju.  Prikazano je  konstruiranje  dijela
transportera upotrebom softverskog paketa SolidWorks,
izrada crteza upotrebom racunala, te izrada NC programa
koriste¢i softver ToPs 300. U ovom koraku kod sheet
metal proizvoda, nakon $to se modelira 3D dio, krece se
sa razvijanjem plasta dijela, koji naknadno koristimo kod
izrade CNC programa.

Upotreba CAD — CAM softvera omogucila je mnogo
manje potrebnog vremena kako bi se trazeni proizvod
mogao konstruirati, izraditi potrebni crtezi, optimizirati
strojeve, izraditi NC programe te ih jednostavno poslati
na stroj za pocetak proizvodnje. Danasnje lansiranje
proizvodnje postalo je mnogo lakSe i omoguéene su brze
izmjene postojecih rjeSenja.

5. POPIS OZNAKA

radijus savijanja R, mm
K — faktor

debljina materijala T, mm
udaljenost do neutralne plohe t, mm
kut savijanja A, ©

ZAHVALA

Ovaj je Cclanak rezultat diplomskog rada studenta
Marijana Bencic¢a koji su zajednicki vodili Izv. prof. dr.
sc. Branimir BariSi¢ i prof. dr. sc. Gyula Varga u okviru
CEEPUS 11 HR 0108 projekta. 1z navedenog razloga
autori zahvaljuju Nacionalnom CEEPUS uredu Hrvatske
(voditelj Davor Sovagovi¢) i Nacionalnom CEEPUS
uredu Madarske (voditelji Katalin Kurucz, Mariann
Veress i Monika Madai) na omoguéenoj stipendiji za
studenta Marijana Bencica.

4. CONCLUSION

Computer Aided Drafting or Design (CAD) and
Computer Aided Manufacturing (CAM) is a software
program which helps in the modeling, development and
optimization of parts. They represent the replacement for
traditional engineering. CAD allows the constructor to
construct and develop the work on a screen, printing the
documents, and it also allows the work to be saved for
later use, eventual editing, and modification of the present
model by modeling a new one. It helps to make time for
the modeling of the new parts shorter. We can say that
CAD offers such benefits as lower prices of the product
and a shorter construction time.

CAM is a program tool which helps in the production of
physical models by using CAD programs.

This work shows one such CAD — CAM production. The
modeling of part of the transporter is shown, using the
SolidWorks software packet, making a drawing using a
computer, and the building of NC program using ToPs
300 software. In this step by sheet metal products, after
the 3D part is modeled begins the unfolding of the 3D
model, which we use later during the building of the CNC
program.

The use of the CAD — CAM software enabled less time
needed for the construction of the product, making
necessary drawings, optimization of the machines,
making NC programs, and easily sending them on the
machine for the beginning of production. Nowadays, the
launching of production became much easier and faster
changes in present solutions are enabled.

5. LIST OF SYMBOLS

inner radius of bending

K — factor

thickness of material
distance to the neutral plane
bend angle
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